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Background 
 

GPlates gives us the functionality to do age-based masking of raster 
data,and this means any age-grid can be used to mask underlying rasters 
which in turn can be cookie-cut by polygons and rotated to their position 
in the past. It is also possible to specify a surface extent of any longitude 
and latitude range for the raster, enabling rasters of a smaller size to be 
correctly sized and positioned on the globe.  
 
In this tutorial we will be working on importing and visualising raster data 
in GPlates and rotating and masking raster data back through time. For all 
those computer illiterate folk out there, a raster is simply a file which is 
made of 2-dimensional grid of pixels and is stored as JPEGS or grid files 
like netCDF. This is different to vector data we have used in previous 
tutorials, that are composed of points, lines and polygons. 

Included Files 
 

 
Click here​ to download the data bundle for this tutorial. 
 
 
For this tutorial we will be using a few different sets of files. These 
include: 
 

● Time-dependent raster sequences of reconstructed ocean floor age 
as published by Müller, Sdrolias et al. [2008] from the EarthByte 
group. 

● Sample raster images of time-dependent dynamic topography 
created by Bernhard Steinberger, based on a dynamic topography 
model published by Müller, Steinberger et al [2008] 

ftp://ftp.earthbyte.org/earthbyte/GPlates/TutorialData_GPlates1.5/3.1-Introduction_to_Rasters_and_Time-Dependent_Rasters_Data.zip


● The MIT-P08 tomography model of the P-wave velocities published 
by Li et al [2008]. 

● A detailed colour image of the global topography and bathymetry 
color_etopo1_ice_low.jpg published by the US National Oceanic and 
Atmosphere Administration. 

● A set of global polygons that represent the Coastlines in GPlates 
Seton_etal_ESR2012_Coastlines_2012.1_Polygon.gpmlz 

● A rotation file which provides the plate kinematic model so we can 
rotate our feature (such as the coastline polygons) through time 
Seton_etal_ESR2012_2012.1  

 
All these files-apart from the ETOPO1 image- are also available in the 
Sample data folder (see Appdix A) along with your GPlates installation. 
Make sure that you know where you can find the Sample data folder and 
how to navigate to the (sub-)directories.​ ( ETOPO1 jpeg is in the MCOSX​) 
 
This tutorial dataset is compatible with GPlates 1.5.  



 

 

Exercise 1: Working with raster data 
 

Loading raster data 

This first exercise is going to walk you through the steps of importing a 
a raster into GPlates. 
 
File→Import→Import Raster→ 
Raster_Tutorial_Data→color_etopo1_ice_low.jpg (fig1a) 
 
 

 
 ​Figure 1a. How to import a raster 

 

The dialogue then will ask you to assign a certain band to the raster 
image (Figure 1b). You can choose between the “band 1” when loading a 
normal raster (as you are now) or “age” depending on whether it is a 
Time-dependent raster. Chose “band 1”. Select “Next”. 
 
 
 
 



 
Figure 1b.  Assigning Raster band names 
 
A Georeferencing Box will open (fig.1c). ​ ​This dialogue box enables you to 
set the geographic extent of the raster. The default is set to a global 
extent. As we want the raster to cover the globe check the extents are set 
to ​top and bottom as 90.000° and -90.000° respectively, and left and 
right as -180.000 and 180.000 respectively​. Later on in this tutorial we 
will go through an example of using a regional raster.​  Select “Next”. 
 
 



 
Figure 1c. Assigning Latitudinal and longitudinal extent to raster 
 
The final step is to create a feature collection. Select “create new feature 
collection” and Select finish. Note in the bottom of this box there is a 
message informing you that the raster metadata (​metadata is loosely 
defined as data about data) will be saved in a GPML file in the same 
directory. Instead of importing the raster again, you can simply go to File 
-->Open Feature collection



 

 
Figure 1d. Creating a feature collection for raster 

Figure 1e. color_etopo1_ice_low Raster imported into Gplates successfully. 

 

Exercise 2: Time-dependent rasters



 

 

Now we will visualise time-dependent rasters in GPlates. Time depednent 
rasters are a series of rasters that have been age-coded so we can 
observe the evolution of a dataset through time. In the following 
exercises we will be observing snapshots of geodynamic models of 
dynamic topography (Appendix. A) and depth slices from seismic 
tomography models which are coded to geological age. 
 

2.1 Time-dependent rasters: global dynamic topography 

Dynamic topography is vertical motion of the Earths surface attributed to 
mantle processes. For example, dense, sinking material, such as 
subducting slabs, drag down over-lying crust, whereas buoyant upwellings 
push up overlying crust. For an informative overview of dynamic 
topography, the 2001 Scientific America article “Sculpting the Earth from 
Inside Out by Professor” by Mike Gurnis is a good place to start. 
 
In this exercise we will be importing a sequence of time-dependent raster 
images showing geodynamic model results of dynamic topography since 
the Mid-Cretaceous (0–100 Ma), provided by Bernhard Steinberger (GFZ 
Potsdam). These images have been generated at 1 Myr intervals. 
 
1. Load the time-dependent rasters using the following sequence of 
commands: File→ Import Time-Dependent Raster (Figure 5a). Select the 
'Add directory...' button and locate and select folder called “Dynamic 
Topography” → “jpg” in the tutorial data bundle (Figure 5b). Press ‘Select 
Folder’ (you cannot select an individual JPEG when loading a Raster 
Sequence), press ‘Next”, and leave the band name as “band 1”. Press 
‘Next’ and as our rasters are global, ensure that the lat-lon bounds are 
90◦ to -90◦ and -180◦ to 180◦. Press ’Next’ again and create a new feature 
collection by selecting Done. You can also tick the checkbox in the last 
dialogue to save a *.gpml file storing your settings. 
 
 



 

(A) 

 
 



 

(B) 

Figure 5.​ ​(A)​ Navigating the menu bar to import time-dependent raster sequences. ​(B) 
Once a directory has been selected, the series of jpegs contained within that directory will 
be displayed next their corresponding age. 
 
 

2. To make these rasters more geographically meaningful, lets open a 
coastline file and add this to the GPlates main window: Go to File → Open 
Feature Collection and locate 
Seton_etal_ESR2012_Coastlines_2012.1_Polygon.gpmlz in the tutorial 
data bundle. Click Open to add the file. 
 
3. What are we missing? Unless we load a rotation file the coastlines (and 
any other datasets we want to visualise) will remain fixed in present-day 
coordinates. Use the same commands as in the previous step to load the 
file Seton_etal_ESR2012_2012.1.rot of the tutorial sample data bundle to 
open the file. 
 
4. Now use the Animation Controls and/or Time Controls (in the Main 
Window above the globe; Fig. 6) to reconstruct the image sequence back 



 

through time. Blues indicate faster seismic waves travelling through 
colder, denser material which pulls the lithosphere down resulting in 
negative dynamic topography, whereas reds indicate waves travelling 
through hotter less dense material which pushes the lithosphere up 
resulting in positive dynamic topography. To watch the evolution of the 
dynamic evolution of the Earth’s surface since 100 Ma, set the time to 
100.00 and then press the play button. See the Reconstructions section in 
the GPlates manual for more details about manipulating animations. 
 
 

 

Figure 6. ​Time and Animation controls in the main window. You may use these controls to 
manually enter a time, move the slider to reconstruct the globe or animate from a selected 
time to the present. 
 
 

2.2 Dynamic topography and tectonics in Australasia 

Time-dependent raster sequences can be combined with other 
reconstructable datasets in order to analyse and investigate features in 
the geological record. We will now exploit this functionality in order to see 
why dynamic topography is reflected in the geological record of several 
Australian basins and oceanic plateaus. Evidence for negative dynamic 
topography can be expressed as anomalous tectonic subsidence. By 
analysing stratigraphic data (obtained from exploration wells) we can 
calculate how a region has subsided over time. Anomalous subsidence is 
the long term lithospheric sinking that can not be explained by the usual 
reasons. That is subsidence expected from thermal cooling resulting from 
lithospheric stretching, or flexure due to the emplacement of a heavy 
load. Knowledge of the tectonic history of the region in question will 
further help determine if dynamic topography( the lithospheric 
topography changing due to mantle convection) is a potential cause of the 
anomalous subsidence. 
 
Cenozoic anomalous tectonic subsidence, induced by mantle convection 
processes, is recorded in wells north and northeast of Australia [e.g. 
DiCaprio et al., 2009, Heine et al., 2010, DiCaprio et al., 2010]. If 
subsidence has occurred, a basin will form and sedimentation will 
increase.Thus if the rate of sedimentation in your well core is greater than 
the sediment contribution from lithospheric stretching then you can 
attribute it to dynamic subsidence,and would check this suspicion against 
mantle convection models. In our example the dynamic topography, 
including a 300 m downward tilt of the continent to the north- east, is due 
to the Australian Plate migrating towards the subduction zones of 
Southeast Asia [DiCaprio et al., 2009]. We will now load into GPlates the 



outlines of the Carpentaria Basin (N of Australia), Queensland Plateau (NE 
of Australia) and Marion Plateau (NE of Australia); focus regions of the 
above authors. 
 
1. Locate and open the files CarpentariaBasin.gpml, 
QueenslandPlateau.gpml and MarionTerrane.gpml from the tutorial data 
bundle. 
 
2. We will also load in the locations of several wells that have recorded 
anomalous tectonic subsidence in the Cenozoic. We will do this using the 
option to load files also from the Feature Manager: File → Manage Feature 
Collections. Click on the Open File button and load the file 
Wells_Australia.gpml. 
 
3. We will now adjust the colouring of the line and polygon data to make 
it easier to see: go to Features → Manage Colouring and from the Feature 
collection drop down menu select All → Single colour and select “Black” 
(Fig. 7). Now we can clearly see the coastlines, wells and basin/plateau 
outlines. 
 
 

 

(A) 

 



 

(B) 
 
Figure 7.​ Altering the colouring of our loaded data sets and setting a uniform colour to all 
loaded feature collections using the colour dialogue. (A) Navigating the menu bar to open 
the Manage Colouring window. (B) Changing the colour of all feature data to black. 
 
 

4. Now play the animation through from 100–0 Ma (as you did previously 
at the end of ex 2.1). 
 
How does the dynamic topography signal evolve in the focus areas we 
have loaded? 
 
You will notice that the negative signal strengthens as Australia migrates 
in a north-northeasterly direction. 
 
 



 

 

Figure 8. ​View of the Australian region with Gulf of Carpentaria basin outline and the 
Duyken-1 well (black dot) as well as the Marion and Queensland Plateau polygons and 
other well data. Background are time-dependent dynamic topography images. 

2.3 Loading Time-dependent Raster Sequences and finding the 

Sundaland slab window 

For the next exercise you will require the following two regional raster 
bundles included in the tutorial dataset: 
 

Montelli06_S (Regional dataset) 
 

MITP0-08 (Regional dataset) 
 
We will now be using a combination of regional time-dependent rasters 
and reconstructable data sets to reveal an assumed Late Cretaceous-Early 
Tertiary ‘slab window’ beneath Sundaland (Whittaker et al., 2007) – a 
region of Southeast Asia comprising the Malay Peninsula, Borneo, Java, 
Sumatra and the surrounding islands. 
 

Slab Windows 

Slab windows form as a result of spreading ridges intersecting subduction 
zones. When ridges are subducted the down-going plates continue to 
diverge, yet due to an absence of ocean water to cool the upwelling 



asthenosphere and form new oceanic crust, the plates no longer continue 
to grow and a gap develops and widens. Seismic tomography enables us 
to visualise slab windows from present-day and past subduction. 
 

Seismic Tomography 

Seismic tomography is a method of imaging the Earth’s interior to reveal 
regions of past and present subduction, and hot mantle upwellings. It 
involves establishing how fast seismic waves (elastic waves) travel 
through the mantle, for example seismic waves generated by 
earthquakes. This information is then used to infer regions of anomalously 
hot or cold material; ‘anomalous’ is judged as deviating from a global 
reference model. As the speed of seismic waves travelling through the 
mantle is influenced by temperature, velocity can be used as a proxy for 
temperature (fast velocities = cold material, slow velocities = hot 
material). However, mantle composition also affects the speed of wave 
propagation, and therefore establishing correlations between velocities 
and mantle structures is not simple. 
 
The included data bundle includes 2 sequences of regional 
time-dependent raster images, and one global time-dependent raster 
sequence, showing seismic tomography. These images were generated 
from the seismic tomography model PRI-S05 (Montelli et al., 2006) and 
model MIT-P08 (Li et al., 2008). Although seismic tomography is a 
method for imaging the structure of the present-day mantle, by 
establishing a relationship between slab depth and slab age (i.e. when the 
slab was being subducted at the surface, NOT the age of the oceanic 
crust) we can use tomography data to learn about past subduction zones. 
By examining the relationship between subducted materials sinking 
velocity and its current depth, we can make estimates about the age of 
subducted material. Table 1 displays the corresponding depth of the age 
coded tomography slices. 
 



 
Table 1.​ Age – depth relationship for tomography slices based on Lithgow-Bertelloni and 
Richards (1998). 

 
You can load Time-dependent Raster Sequences, which are raster images 
whose pixels change according to the reconstruction time. 



 
Presently, GPlates can open RGBA images (which have a Red, Green, Blue 
and optional Alpha value for each pixel in the image) including common 
file formats such as JPEG (JPG), PNG, TIFF and GIF. 
 
If you want to load your own time-dependent raster set, make sure: 
- Each image is a jpg file 
- All files are named: name-time.jpg 
- The time-numbers are integers (time in Ma) 
 
Example: 
Montelli06_P-3.jpg 
Montelli06_P-4.jpg 
Montelli06_P-5.jpg 
etc 
 
For our region of interest time-dependent raster sets already exists. The 
seismic tomography data shows the mantle structure at different depths, 
which are assumed to represent certain ages in the past. 
 
To load the Time-dependent Raster Sequence, select Import 
Time-dependent Raster from the File Menu (Figure 9a). This will open the 
first ‘Import Time-Dependent Raster’ window. 
 
To add raster images, we have two options. 
 
1. If we are using multiple files which are saved in a single folder, we can 
use the ‘Add directory…’ button and select the entire folder in which the 
images are saved. 
 
2. Alternatively, if we are using multiple files which are saved alongside 
other files we do not want to load, or use the ‘Add files...’ button and 
select them all individually. 
 
In this example, we will load the entire folder and use the Montelli 
tomography model. The importing Rasters data bundle also contains the 
MITP08 model, so feel free to try it out also. Keep in mind that for this SE 
Asia example, only the regional MITP08 model (MITP-08_Regional) is 
applicable. 
 



Click the ‘Add directory’ button. Navigate to the folder in which your 
Montelli06_S folder is saved, select it and then click ‘Select Folder’ (Figure 
9b). GPlates will take some time to add the raster file sequence. Don’t 
close the window! 
 

 

 
Figure 9. (a)​ Under the File tab, select ‘Import’, ‘Time-dependent Raster’. ​(b)​ Use the 
‘Add directory’ button to select the folder in which your raster images are saved. In this 



example, this is the folder ‘Montelli06_S’ included in the tutorial dataset. 

 
You will see all the individual raster files loaded (Figure 10). Click Next. 
 

 
Figure 10. ​The first ‘Import Time-Dependent Raster’ window with all raster files loaded. 
 

In the second window, you are asked to specify band names. Keep the 
default and click Next. 
 
In the third window, under Georeferencing, you are asked to specify the 
location of raster using latitude and longitude. Since this is a regional 
raster, we are required to specify the position of the image to be in SE 
Asia. If we were instead loading a global raster, which spans the entire 
globe, we would keep the default location as is. 
 
 
For the SE-Asia Montelli data, the coordinates are: 
 

Top (lat): 30.0000° 



 
Bottom (lat): -20.0000° 

 
Left (lon): 80.0000° 

 
Right (lon): 130.000° 

 
Enter these coordinates in and click Next (Figure 11) 
 

 
Figure 11.​ Enter the SE-Asia coordinates for the Montelli raster dataset (Top: 30°, 
Bottom: -20°, Left: 80° and Right: 130°) and click Next. 

 
In the fourth window, you are prompted to create a new feature 
collection. Keep the default (< Create a new feature collection >) and 
press Finish. 
 
After you have changed the Camera Position you should be able to see 
the seismic tomography for the SE-Asian region (Figure 12). 
 



 
Figure 12.​ Seismic tomography of the SE Asian Region, with the raster surface extent set. 
(a)​ Tomography model is Montelli06_S at 0 Ma. ​(b)​ Tomography model is MITP08 at 50 
Ma. 

 
We want to use seismic tomography to find a hypothesised slab window 
beneath Sundaland in the late Cretaceous-Early Tertiary. 
 
Slabs at subduction zones can be seen in seismic tomography images as 
regions of anomalously fast velocities (blue areas in our figures), because 
the slabs are colder and denser than the surrounding mantle. 
 
A slab window can be seen as a break in the fast subducted slab. 
 
The slab window is thought to have opened approximately between 70Ma 
and 43Ma and can be observed in different models at depths 
representative of these times. 
 
Because the raster images are time-dependent we can animate the 
seismic tomography through time. 
 
For the time-dependent raster sets that already exist for SE-Asia we can 
animate a period from 189 Ma to present day in 1 My time steps. 
 
 
To animate the changes in seismic tomography through time we use the 
Animation Slider at the top of the interface. To reconstruct to a particular 
time, type the required age in Ma into the ‘Time’ text box and press 
Enter. As an example, reconstruct to 50 Ma using the Montelli model 



(Figure 13). 
 

 
Figure 13.​ Reconstruct to a particular time frame by either typing the reconstruction time 
in Ma into the ‘Time’ text box (highlighted in blue, or using the Animation Slider to slide to 
the required reconstruction time (circled in black). Animate the changes in seismic 
tomography through time by pressing the Play button (circled in black) 

 
 
To start the animation, press the Play button. The animation will start in 
the past (at the age at which you initially specified) and end at present 
day. 
 
If you want to stop the animation press Pause (same button as Play). 
 
By using the Fast Forward and the Rewind buttons you can watch the 
reconstruction in small steps. Press the Fast Forward/Rewind button once 
to adjust the current reconstruction time by one timestep 
forwards/backwards. The default timestep is 1 Ma. 
 
You can also use shortcut keys: 
 

Ctrl (CMD) + I = forwards 
 

Ctrl (CMD) + Shift + I = backwards 



 
By keeping the button pressed or the shortcut keys held down you can 
move forwards/backwards faster. 
 
In the Animation Dialog (Figure 14) you can adjust the start and the end 
time for your reconstruction. To access this click Reconstruction menu and 
select Configure Animation 
 

 
Figure 14.​ Animation Dialog 

 
For our data you can choose any start time between 189 to 1 Ma. 
 
In the Animation Dialog (Figure 14) you can also adjust the frames per 
second and the increment per frame. 
 
Default settings are: 
 

200 Ma for the start time and 0 Ma for the end time of the 
animation 
 

5 frames per second 
 

1 Ma increment per frame 



 
If you want your animation to start at present day and go back in time 
you can choose Reverse the Animation from the Animation Dialog 
 
To find our slab window we don’t need our animation to start at 140 Ma. 
Change the start time for the animation to 80 Ma and the end time to 30 
Ma. 
 
Try to find the slab window in the different raster sequences. Look for 
red-yellow gaps that appear to break up a continuous blue band. The blue 
represents the colder oceanic slab being subducted, and the red 
representing the hot mantle upwelling through the gap or ‘window’in the 
slabs. 
 
You may find that turning off the coastlines layer by clicking the Eye in 
the ‘Layers’ window may make things less confusing (Figure 15). 
 

 
Figure 15.​ (a) Slab window in Sundaland using the Montelli06_S model at 70 Ma (left), 56 
Ma (middle) and 43 Ma (right) 

 
You will find that in the MITP08 model, a slab window begins to form at 
63 Ma when a section of red intersects a blue band, and disappears at 38 
Ma when the blue band becomes continuous once more (Figure 16). 
 



 
Figure 16.​ (a) Slab window in the MITP08 model at 63 Ma (left), 57Ma (middle) and 44Ma 
(right) 

 

Exercise 3: Creating new features: Digitising a new slab 

window feature in Sundaland 

 

 
GPlates provides the opportunity to interactively create new features. 
 
We want to digitise our slab window in Sundaland, create a new feature 
and export it in a format that can be used in other programs (e.g. GMT). 
 
To digitize our slab window we need the ‘Digitisation Tools’ from the Tool 
Palette on the left hand side of the globe. 
 
When you click on the ‘Digitisation Tools’ icon, seven further options 
appear (Figure 17). These include: 
 

Measure 
 

Digitise New Polyline Geometry 
 

Digitise New Multi-Point Geometry 
 

Digitise New Polygon Geometry 
 

Move Vertex 
 

Insert Vertex 
 



Delete Vertex 
 

 
 
Figure 17.​ Under the ‘Digitisation Tools’ icon, you will find Measure, Digitise new Polyline 
Geometry, Digitise new Multi-Point Geometry, Digitise new Polygon Geometry (circled), 
Move Vertex, Insert Vertex and Delete Vertex. 

 
Depending on which kind of feature you want to create you need a certain 
geometry. 
 
For our slab window we will choose the Polygon Tool. Click on the ‘Digitise 
New Polygon Geometry’ button to select the tool (Figure 17). 
 
After a digitisation tool has been selected every mouse click creates a new 
vertex. If you make a mistake, click ‘Undo’ under the Edit tab, or 
alternatively use the Undo shortcut on your keyboard (Ctrl + Z). 
 
To digitise the position of our slab window, we will choose to draw an oval 
shape. 
 
Note that GPlates can only digitise straight lines - to create an oval shape, 
we must digitise several points so that the polygon will appear 
oval-shaped, despite being composed of several straight lines. 
 
Before we digitise the slab window, we need to do a few more things. 



 
The slab window opened approximately beneath the Sunda-Java-Trench 
and extended to the north so it is helpful to see the coastline again. Tick 
the box beside the Coastlines layer in the ‘Layers’ window. 
 
Change the Coastlines layer to black by using the ‘Manage Colouring’ tool 
under the ‘Features’ tab. Select the Coastlines layer in the drop-down 
menu, then on the left click SingleColour, then choose Black and click OK 
(Figure 18). 
 

 
Figure 18.​ Changing the Coastlines layer to black using ‘Manage Colouring’.  
 

Because we want them to change position through time we need to load a 
rotation file as well. The rotation file contains Longitude, Latitude and the 
angle of rotation for each plate. 
 
If you haven’t already loaded it, use ‘Open Feature Collection’ and select 
the file Seton_etal_ESR2012_2012.1.rot from your data bundle. If it is 
already loaded, you should see it in the ‘Layers’ window. 
 
We are now ready to digitise. 
 



Ensure you have selected the ‘Digitise New Polygon Geometry’ tool. 
 
Set the Reconstruction Time to 70 Ma and start digitizing the slab window 
by clicking successive points. 
 
As before, click ‘Undo’ or use the shortcut Ctrl + Z to undo your last point 
if you make a mistake. 
 
Your slab window should look approximately like the figure below (Figure 
19). 
 

 
Figure 19.​ Sundaland slab window at 70 Ma digitised using the ‘Digitise New Polygon 
Geometry’ tool, based on the Montelli tomography model. 
 
 

You may have also noticed that for every vertex digitised, their 
coordinates can be seen in the ‘New Geometry’ Table on the right hand 
side of the globe (Figure 20). 
 



 
 
Figure 20.​ The latitude and longitude coordinates of the newly digitised vertices displayed 
in the New Geometry Table. 
 
 
 

If you don’t like the shape you can move the vertices, add new vertices or 
delete those you don’t like using the editing tools from the tool palette. 
 

 Move Vertex 
 

 Insert Vertex 
 

 Remove Vertex 
 



 
 
Figure 21 shows the digitized slab window after Move Vertex has been 
selected. Each vertex (dot) can now be moved. 
 
If you want to add a vertex, select Insert Vertex and click on the line at 
the spot you want to add a dot. 
 
You can move the new vertex later if you don’t like the position. 
 
If you want to remove a vertex, select Remove Vertex and click on the 
dot you would like to remove. 
 

 
Figure 21.​ Digitised slab window after editing tool has been selected. 
 
 

Once you are happy with the shape of your slab window you export it in a 
format GMT can read. 
 



To export a feature the Digitization Tool (not the Vertex tool) has to be 
selected. 
 
Click ‘Export Coordinates’ beneath the Geometry Table. 
 
The Export Coordinates Window will open and ask you to choose a format, 
the coordinate order and a destination (Figure 22). 
 
Choose the Generic Mapping Tools (GMT) format. 
 
Make sure the Coordinate order is Latitude, Longitude. 
 
Export destination as a ‘File’. Click ‘Export’, and navigate to the folder in 
which you would like to save your slab window to. Specify the filename. 
Click Save. 
 

 
 
Figure 22.​ In the ‘Export Coordinates’ window, choose the Generic Mapping Tools (GMT) 
format, the coordinate order of Latitude, Longitude, a destination, and a filename. Click 
Export, after which you can specify the filename and destination. 
 
 

If you want to load the feature in GPlates later again, you have to create 
a new feature using these coordinates. 
 
To create a new feature click ‘Create Feature’ beneath the Geometry 
Table. 
 



In the first Create Feature window, you will be asked to select a feature 
type. Select ‘Unclassified Feature’ for the slab window (Figure 23). 
 

 
Figure 23.​ In the first ‘Create Feature’ window, select ‘gmpl:UnclassifiedFeature’ as the 
Feature type. Click Next. 

 
Click Next. 
 
In the next ‘Create Feature’ window, leave the default setting for the 
geometry’s purpose (Boundary). 
 
You have to give your feature a Plate ID (Figure 24). It has to be the ID 
of the plate your feature is located on. In our case the slab window is on 
the Eurasian Plate. Type 301 for Plate ID which is the Eurasian Plate ID. 
 
You have to give your feature a time of appearance and disappearance. In 
our example, we digitized the slab window at 70Ma. 
 
Select 70Ma for Begin (Figure 24). 
 
For End you can either tick Distant Future if you don’t know exactly when 
it disappeared or select an End time. 
 
For our slab window tick Distant Future for End (Figure 24). 
 



Finally, give it a name (e.g. SlabwindowMontelli06_S70Ma) and click 
Next. 
 

 
 
Figure 24.​ Create Feature Dialog. This is where most of the features attributes are set. 
Set the geometry property to Boundary, the Plate ID to 301 (the Eurasian Plate), the Begin 
time to 70 Ma, the End time to Distant Future, and the name (e.g. 
SlabwindowMontelli06_S70Ma). 
 
 

In the third ‘Create Feature’ window, keep all defaults and click Next. 
 
In the fourth ‘Create Feature’ window, select < Create a new Feature 
Collection > at the bottom of the list. Click Create. 
 
 
You’ve now created a new feature, but it hasn’t been saved yet. 
 
Open your Manage Feature Collection Dialog and save the feature as a 
dat-file by clicking the Save As button. Specify a filename and location in 
the finder window. You have now saved your new slab window feature! 
 
 
This is just an example using one tomography model. If you would like to 
compare the different models, go back to step 8 and load a new set of 



time dependant rasters from the folder called MIT-P08. 
 
GPlates can further be employed to compare the location of the slab 
window inferred from seismic tomography with its location inferred from 
other data sources, for example plate tectonic reconstructions. We will 
now load in EarthByte’s time-dependent crustal age sequence from the 
Importing_Rasters data bundle. 
 
Select ‘Import Time-dependent Raster Sequences’ from the File Menu. 
 
A finder window will pop up. Use either the ‘Add directory...’ or ‘Add 
files...’ to select the ‘AgeGrids’ from the GPlates Sample 
Data/Rasters/Time-dependent raster sequences. Note that this will take 
time to load, like all raster sequences. Do not quit! 
 
In the second window, we must assign band names to the bands in the 
raster. Leave the settings on default, and click ‘Next’. 
 
In the third window,  you no longer to have specify the location of the 
raster since this is a global raster sequence. Therefore, keep the default 
coordinates (Top: 90°, Bottom: -90°, Left: -180° and Right: 180°). 
 
Create a new feature collection and press Finish. 
 
Spend some time reconstructing the raster sequence using the Animation 
and/or Time controls – you can see how old the oceanic crust is in various 
areas of the world. Note that the youngest oceanic crust is red. 
 
We will now compare the location of the slab window that you inferred 
from seismic tomography to the location where the youngest oceanic 
crust (and hence the crust adjacent to the spreading ridge) is being 
subducted beneath Sundaland – for simplification we will assume that the 
spreading ridge is positioned at the centre of the youngest oceanic crust 
(Figure 25). 
 
In other words we will be comparing ‘our’ slab window with the 
approximate location of the slab window inferred from a plate kinematic 
reconstruction. Note once more that the youngest crust is coloured red, 
and that the edges of the coloured age grids signify continent-oceanic 
boundaries (COBs). 
 



 
 
Figure 25.​ 60 Ma reconstruction of ocean floor ages and present-day coastlines. Notice 
that the youngest oceanic crust (and hence the spreading ridge) is converging with 
western most Sundaland. Compare this figure with your polygon you have digitised. 
 
 

Rotate the globe to centre on Sundaland and use the Time controls to 
jump to 60 Ma. Turn the slab window layer back on. 
 
* How does your digitised slab window compare to the location of 
subduction of the Wharton Ridge (and hence the kinematically inferred 
slab window)? 
 
If you would like to learn more about how seismic tomography is being 
used to constrain the location of the Wharton Ridge and slab window 
beneath Sundaland during the Late Cretaceous to Early Tertiary, see 
Fabian et al. (2010). 
 
* You will find that the digitised slab window tends to correlate with the 
younger ocean floor (red). This is consistent with the definition of slab 
window formation earlier: spreading ridges intersecting subduction zones. 
 

 



Exercise 4: Finding and digitising the Caribbean slab 

window: how is it different to Sundaland’s? 

 

 
For the next exercise you will require the following global raster bundle 
included in the tutorial dataset: 
 

MITP08 (-0.6 0.6 0.05) (Global dataset) 
 
Similarly to the previous exercise, we will now be using a combination of 
global time-dependent rasters and reconstructable data sets to reveal an 
assumed Mid-Late Tertiary ‘slab window’ beneath the Caribbean 
(Breitsprecher and Thorkelson, 2009 and Van Benthem, 2012) - a region 
of Central America comprising the Cayman Islands, Cuba, Jamaica, Costa 
Rica, Panama and other neighbouring regions. 
 
We will find and digitise the Caribbean slab window in much the same way 
as we did the Sundaland slab window. However, upon comparing the 
location of the digitised slab window relative to the subduction zone and 
other plate boundaries, we may find some differences. 
 
Load the Time-dependent Raster Sequence comprising the global MITP08 
dataset by selecting Import Time-dependent Raster from the File Menu. 
 
Use either the ‘Add directory...’ to select the folder MITP0_Global from 
where it is saved, or the ‘Add files...’ button to select all 62 MITP08 raster 
images from the folder. When all the files are loaded, click Next (Figure 
26). 
 



 
 
Figure 26​. Once the complete raster sequence comprising the global MITP08 dataset is 
loaded in the Import Time-Dependent Raster window, click Next. 
 
 

Click Next again. In the next window, keep the default Georeferencing 
coordinates since this is a global raster, then click Next. Keep the default 
Select <Create a new feature collection> in the next window, and press 
Finish. 
 
We will now turn off all layers in the Layers dialog except for the 
Coastlines and the global MITP08 dataset we have just imported (Figure 
27). 
 
Centre the globe on Central America. Since the slab window is 
hypothesised to begin in the mid-late Tertiary, reconstruct to 40 Ma 
(Figure 27). 
 



 
Figure 27.​ Turn on the Coastlines and the global MITP08 layers in the Layers dialog. 
Centre the globe on Central America and reconstruct to 40 Ma 
 

Now we will attempt to locate the Caribbean slab window and determine 
when it began to form. Remember that you are looking for red-yellow 
gaps that intersect continuous blue band, which may indicate the 
presence of a slab window. 
 
Animate back and forth from 40 Ma to present day using the time slider. 
Try to find the slab window, and again if you find the coastlines confusing, 
turn them off in the Layers window and just leave the raster visible. 
 
You will find that a slab window begins to form at 24 Ma and continues 
until present day. 
 



 
Figure 28.​ (a) Slab window in the Caribbean using the global MITP08 model at 24 Ma 
(left), 17 Ma (middle) and 7 Ma (right) 
 
 

Digitise the slab window using the ‘Digitise New Polygon Geometry’ tool 
under the Digitisation button on the left. We will choose to draw an oval 
shape. 
 
Reconstruct to any time between 24 and 0 Ma and use this reconstruction 
time as the basis for your slab window digitisation. 
 
Keep in mind however that the slab window (the red section) seems to 
progressively get larger, so bear this in mind while digitising. It may be 
worthwhile digitising the entire extent of the slab window in its later 
stages rather than digitising a small window in its early days. 
 
For this reason, we have chosen 10 Ma as our reconstruction time. 
 
As before, click successive points to digitise the slab window, and click 
‘Undo’ to remove your last digitised point if you have made a mistake. 
 
Your slab window should look approximately like the figure below. Notice 
the coordinates of every vertex of your new polygon can be seen in the 
‘New Geometry’ Table on the right hand side of the globe (Figure 29). 
 



 
Figure 29.​ Caribbean slab window at 10 Ma digitised using the ‘Digitise New Polygon 
Geometry’ tool, based on the global MITP08 tomography model. 
 

While not a necessary step, you may wish to export the digitised slab 
window in GMT format. To do this, click ‘Export Coordinates’ beneath the 
Geometry table. 
 
In the Export Coordinates window, choose the Generic Mapping Tools 
(GMT) format and ensure the Coordinate order is Latitude, Longitude. 
Export destination as ‘File’, click ‘Export’ and then specify the filename 
and file destination before clicking ‘Save’. 
 
We will now save our digitised slab window as a feature which can be 
loaded into GPlates as a layer. 
 
To do this, click ‘Create Feature’ beneath the Geometry Table. Select 
‘Unclassified Feature’ for the slab window. Leave the geometry’s purpose 
as ‘Boundary’ in the next window. Give your feature a plate ID of 201 
(South American Plate), a Begin time of 24 Ma, and an End time of 
‘Distant Future’. Specify a name such as ‘SlabwindowMITP08_24Ma’ 
(Figure 30). 



 

 
Figure 30.​ Create Feature Dialog. This is where most of the features attributes are set. 
Set the geometry property to Boundary, the Plate ID to 201 (the South American Plate), 
the Begin time to 24 Ma, the End time to Distant Future, and the name (e.g. 
SlabwindowMITP08_24Ma). 
 
 

In the third ‘Create Feature’ window, keep all defaults and click Next. 
In the fourth ‘Create Feature’ window, select < Create a new Feature 
Collection > at the bottom of the list. Click Create. 
 
Save the feature in the Manage Feature Collection Dialog by clicking the 
Save As button. Specify a filename and location in the finder window. 
 
Now we have finished locating and digitising the Caribbean slab window. 
 
We will now compare, as we did in Sundaland, the location of the slab 
window that you inferred from seismic tomography to where the youngest 
crust is, signifying the location of ridge. 
 
Again, for simplification we will assume that the spreading ridge is 
positioned at the centre of the youngest oceanic crust (coloured red) and 
that the edges of the coloured age grids signify continent-oceanic 
boundaries (COBs). 
 



Turn on the age grid layer in the Layers dialog and begin comparing it 
with the location of your digitised slab window. 
 
If you cannot see your age grid layer, chances are it is sitting underneath 
the MITP08 layer. To rectify this, you can either turn off the MITP08 layer, 
or drag the age grid layer above the MITP08 layer but clicking and 
dragging the coloured bar beside the name. This positions the age grid 
layer on top of the MITP08 layer, and will instead hide the MITP08 layer 
despite it still being a ‘visible’, turned on layer. 
Spend some time reconstructing the raster sequence back and forth in 
time using the Animation and/or Time controls. Your slab window should 
be in a similar position to this at 24 Ma when loaded with the age grids 
(Figure 31). 
 

 
Figure 31.​ The digitised Caribbean slab window reconstructed at 24 Ma with age grids 
loaded. Red = youngest sea floor. 

 
** How does the location of your digitised slab window relative to young 
seafloor and mid-ocean ridges differ from the location of Sundaland’s slab 
window? 
 
** You will find there is no mid-ocean ridge, nor younger seafloor (red), 
that correlates to the location of the digitised Caribbean slab window. 
This, in contrast to Sundaland, is not consistent with the definition of slab 
window formation. 
 



An alternative explanation for the slab window is that it is actually a slab 
tear unrelated to the subduction of a mid ocean ridge. Slab tears may 
form when a zone of weakness in a plate is opened up during subduction, 
whereby allowing warm asthenosphere to flow through. For example, slab 
tears may possibly result from the intersection of transform faults or 
fracture zones with subduction zones. 
 
We will use fracture zone data to investigate the location of our slab 
window relative to these fracture zones. 
 
 
Load the following fracture zone dataset into GPlates using ‘Open Feature 
Collection’: 
 

Matthews_etal_2011_Fracture_Zones.gpml 
 
 
We are essentially looking for fracture zones which point towards and line 
up with our digitised slab window. 
 
These lined-up fracture zones will become the plane of weakness by which 
the slab could have torn, resulting in the upwelling of mantle and what 
seems to be a ‘slab window’ in the tomography. 
 
Note that these fracture zones are perpendicular to the spreading ridge 
and will continue to subduct underneath the Caribbean plate. Therefore 
you can extrapolate the present day fracture zones to the point of 
intersection with the subduction zone. There are no present day fracture 
zones adjacent to Central/North America at times in the past. The 
seafloor that was adjacent to North/Central America at times in the past 
has since been subducted and is in the mantle now! 
 
 
*** Do any fracture zones correlate with the location of your digitised 
slab window? 
 
 
 
*** You will find that there are a couple of fracture zones which point 
towards and correlate with the location of our slab window, suggesting 
that they may be the cause of what could be a slab tear instead of a slab 



window in the Caribbean (Figure 32). 
 

 
 
Figure 32.​ Fracture zone data correlated with the location of our digitised slab window 
(pink). The extrapolation of two potential fracture zones are symbolised by black arrows. 
The slab window shows no correlation with ridges of young seafloor (red). 
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A. Terminology 

 
GPML  
The GPlates Markup Language. GPML is a “dialect” of XML, in- corporating 
features of the Geopgraphic Markup Language. Essentially, the GPlates 
data model is using markup language to represent any feature (ie. 
geographic object). 
 
Sample data  
When you download GPlates from http://www.gplates.org, some sample 
data is included in your download. On Windows, this will be available after 
the installation in the GPlates folder at C:\Program Files\GPlates\GPlates 
[version]\Sample data. For the Mac, the download will leave you with a 
disk image (*.dmg) file. Mount the file by double-clicking, drag the 
GPlates application bundle into the Applications folder. The sample data is 
included as directory (“sample-data”) in the top level of the disk image. 
 
Raster data  
Raster images comprise 2-dimensional grids of pixels, or points of colour, 
that are stored in image files such as JPEGS or grid files like netCDF. Note 
that they differ from vector images that are composed of points and line 
segments. 
 
Feature  
Any reconstructable object which can be loaded in GPlates. Features can 
be lines, points or polygons or multi-* geometries as well as raster 
images. 
 
Slab Windows  
Slab windows form as a result of spreading ridges intersecting subduction 



 

zones (Dickinson and Snyder, 1979). When ridges are subducted the 
down-going plates continue to diverge, yet due to an ab- sence of ocean 
water to cool the upwelling asthenosphere and form new oceanic crust, 
the plates no longer continue to grow and a gap develops and widens. 
Seismic tomography enables us to visualise slab windows from 
present-day and past subduction. 
 
Seismic tomography  
Seismic tomography is a method for imaging the Earths interior; revealing 
regions of past and present subduction, and hot mantle upwellings. It 
involves establishing how fast seismic waves (elastic waves) travel 
through the mantle, for example seismic waves generated by 
earthquakes. This information is then used to infer regions of anoma- 
lously hot or cold material; anomalous is judged as deviating from a 
global reference model (e.g. PREM Dziewonski and Anderson, 1981). As 
the speed of seismic waves travelling through the mantle is influ- enced 
by temperature, velocity can be used as a proxy for temperature (fast 
velocities = cold material, slow velocities = hot material). How- ever, 
mantle composition also affects the speed of wave propagation, and 
therefore establishing correlations between velocities and mantle 
structures is not simple. 
 
 

B. Age-depth relationship for seismic tomography 

 
The table below show the conversion of seismic tomography depth slice to 
a certain age. This can then be used as time-dependent raster sequence 
in GPlates. Sinking Rate is approximately 1.3m/yr. 
 



 
Table 1: Age–depth relationship for tomography slices. Data is based on: 
The dynamics of sinking slabs Butterworth, N., Talsma, A.S., Müller, R.D., 
Seton, M, Bunge, H.-P., Schuberth, B.S.A., Shephard,G.E., in prep.  
 
 


